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Chapter 1: Introduction

HP Virtualization Performance Viewer (HP vPV) is a web-based analysis and visualization tool that
analyzes performance trends of elements in virtualized environments. It enables virtualization
monitoring by providing an overview of the environment, near-real-time and historical data analysis
and triaging using an interactive dashboard. It also enables monitoring for cloud and hypervisor
environments. HP vPV helps you visualize performance data for elements in the context of each
other to rapidly analyze bottlenecks. HP vPV provides performance monitoring, graphing, and
reporting in a single interface.

Key features of HP vPV are as follows:
o Monitor the health and performance of the virtualized environment from Dashboard view.

o Triage analysis with the Workbench and capability to trend server utilization across days,
weeks, and a month.

o Proactive monitoring of the entities that may cause disruptions in the environment. Use
Treemap to identify and view the problems at a glance.

« Analyze the capacity, usage, and allocation trends for various resources in a virtualized
environment.

« Right sizing recommendation based on historical resource utilization and reclaiming unused
resources.

o Analyze the impact of increasing the workload.
o Determine the impact of adding or deleting resources in your environment.

o Estimate the future capacity utilization in order to proactively plan your hardware requirements.

Conventions Used in this Document

The following conventions are used in this document when referring to the location of files on the
HP Virtualization Performance Viewer (HP vPV) system:

Convention Description Value
<install_dir> The directory where HP vPV is installed. On Linux systems, the
installation directory is
/opt/Oov.
<data_dir> The common data directory where data files and = The data directory is
log files related to HP Software products are /var/opt/OV.
stored.
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Chapter 2: Installation Requirements

During installation, the installer performs the following tasks:

o Checks if your system meets the disk space requirements. For information on the disk space,
see "Hardware Requirements".

e Checks if your system has any other HP software product installed. For example: HP vPV co-
exists with HP Operations Agent version 11.13.

o Provides a detailed log of the system disk space and other HP software products detected.
o Provides a list of components installed.
Note: HP vPV supports only x64-bit version of the Linux operating system.

The location of the following files used for HP Operations agent co-existence has been changed:

File Name Old Location New Location

Viserver.properties /var/opt/perf /var/opt/OV/conf/PV
VILog4j.xml /var/opt/perf /var/opt/OV/conf/PV
pvcd.jar /opt/perf/bin/java /opt/OV/Ibin/PV/java
log4j-1.2.17 jar /opt/perf/bin/java /opt/OV/Ibin/PV/java

Note: The common jars are moved to /opt/0V/1bin/PV/java. The jars specific to a
technology are part of its SMEPack.

For Example: jars required by VMWARE collector are present in the java folder within the
VMWARE SMEPack.

/opt/0V/newconfig/OVPM/smepack/VMWARE/java

Hardware Requirements

The minimum hardware requirements for installing HP vPV are:

Item Value
CPU 2vCPU
Memory 4GB

Disk 40GB
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Item Value
[opt/ 700 MB
Ivar/ 24 GB

Installing on a slower system or one with less memory may result in slow performance.

The following table lists the hardware requirements for using HP vPV with the Premium and
Express licenses:

Instances
License vCPU RAM Disk Space Monitored
Express 2 4GB 40 GB 2000
Premium 2 4GB 40 GB 1000

"HP vPV can monitor more than 2000 instances by increasing the RAM and CPU. For more
information, see the HP Virtualization Performance Viewer Sizing Guide.

Supported Browsers

The following table lists the web browsers that are required to access HP vPV:

Operating Systems Supported Browsers

Microsoft Windows | Firefox 24 (ESR)
Internet Explorer 10
Internet Explorer 9 (limited support)
Google Chrome (latest version)

Linux Firefox 24 (ESR)

To view the HP vPV home page, install Adobe® Flash Player 10.2 or above and enable JavaScript
support for the Internet Explorer (IE) or Mozilla Firefox browser by adding HP vPV to your list of
Trusted Sites.

Support Matrix
The following table lists the support matrix for HP vPV:

Deliverable Platforms/Versions

Linux Installer RHELG6.2,6.3,6.4,6.5
Cent0S 6.2, 6.4

Virtual appliance | CentOS 6.5
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Chapter 3: Upgrade Scenarios

You can upgrade HP vPV from version 2.00 to 2.01 in the following two ways:
o Upgrading HP vPV using the Installer

e Upgrading HP vPV using the Virtual Appliance

Note: Make sure that you take a snapshot of HP vPV 2.00 machine before upgrading to 2.01
as rollback is not supported.

Upgrading HP vPV using the Installer

If you are already having HP vPV version 2.00 installed in your environment and want to upgrade to
version 2.01, you can upgrade using .tar or .iso. Download the .tar or .iso on your local machine
and install HP vPV on the VM.

Toinstall HP vPV on a VM, see "Install HP vPV on Linux Nodes" on page 13.

Upgrading HP vPV using the Virtual Appliance

If you already have HP vPV version 2.00 deployed on the virtual appliance and want to upgrade to
version 2.01, you can do it in the following two ways:

¢ "Using CDROM Updates (Using .iso)"

+ "Using Specified Repository (Using .zip)"
Using CDROM Updates (Using .iso)

1. Log onto VMware vSphere Client.

2. Inthe left tree pane, select the HP vPV machine that is to be upgraded.

3. Click the Connect/disconnect CD/DVD devices of the virtual machine @ icon. Select
CD/DVD drive1.

4. Click Connect to ISO image on local disk.Windows Explorer appears.
5. Selectthe HPPV_VA_2.01.xxx_UPDATE.isofile. Click Open.

6. Inthe HP vPV 2.00 interface, select Admin and click the Data Sources tab.
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10.

11.

12.

13.

14.

Launch the HP vPV Virtual Appliance Management web interface using the link provided at the
bottom of the page.

Log on to the HP vPV Virtual Appliance using the userame as root. The default password is
vperf*viewer.

Click Update tab. The Update Status page appears.

Click Settings.The Update Settings page appears.

In the Update Repository section, select Use CDROM Updates.
Click Status. The Update Status page appears.

Click Check Updates. The available updates appear.

Select the update and click Install Updates. The upgrade process begins.

Using Specified Repository (Using .zip)

1.

10.

1.

Download and unzip HPPV_VA_2.01.xxx_UPDATE.zip in the Web folder at the server (Web
or FTP) location.

Launch the HP vPV Virtual Appliance Management web interface using the link provided at the
bottom of the page.

Log on to the HP vPV Virtual Appliance using the usemame as root. The default password is
vperf*viewer.

Click Update tab. The Update Status page appears.

Click Settings.The Update Settings page appears.

In the Update Repository section, select Use Specified Repository.

In the Repository URL box, type the server location where the update file is placed.
In the Username and Password box, type the User name and Password, if any.
Click Status. The Update Status page appears.

Click Check Updates. The available updates appear.

Select the update and click Install Updates. The upgrade process begins.
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Verify the Upgrade

You can verify the upgrade to HP vPV version 2.01 by performing either of the following:

¢ Inthe HP vPV interface, go to the Help icon and click About HP vPV. A dialog box appears
with the version information.

o Verify the version by running the following command at the command prompt:

pv version

Note: After the upgrade, it is recommended to check the status of HP vPV processes using
the following command:

/opt/OV/bin/ovc

If any of the processes are not running, run the following command to restart the processes:

pv restart
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Chapter 4: Installing HP vPV

The following section details the different methods to install HP vPV:

"Deploy the HP vPV Virtual Appliance"

"Install HP vPV on Linux Nodes"

Note: HP vPV supports upgrade only from version 2.00 to 2.01.

Pre-requisites

Following are the prerequisites for installing HP vPV:

Ensure that port 8081 is open to make HP vPV accessible from the remote browser, if there is a
firewall on the system where HP vPV is installed.

Ensure that port 8444 is open to access in Hypertext Transfer Protocol Secure (HTTPS) mode.
Ensure that the port used for accessing HP vPV (8081, by default) is open in the firewall, if there
is a firewall between HP vPV and Microsoft System Center Virtual Machine Manager (SCVMM)

server.

Ensure that the port 5480 is open to access the Virtual Appliance Management Interface (VAMI).

Deploy the HP vPV Virtual Appliance

HP vPV is available as a Virtual Appliance for easy deployment in vCenter. You can use the
VMware vSphere Client user interface to deploy the virtual appliance.

The supported VMware vCenter Server versions are 5.0, 5.1, and 5.5.

To deploy the HP vPV virtual appliance, follow these steps:

1.

2.

Open VMware vSphere Client.
Type the credentials and click Login.
Select File > Deploy OVF Template. The Deploy OVF Template window opens.

Click Browse to browse to the location where you have saved the HP vPV virtual appliance
file.

Click Next. The window shows the details of virtual appliance.

Click Next. The End User License Agreement details appear.
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7. Click Accept and then click Next.

8. Type a name for the virtual appliance in the Name field.

9. Select where to deploy the virtual appliance from the Inventory Location tree. Click Next.
10. Select the host or cluster where you want the virtual appliance to run. Click Next.
11. Select the specific host where to run the virtual appliance. Click Next.
12. Select the storage location where you want to store the virtual machine files. Click Next.
13. Select the disk format in which you want to store the virtual disks. Click Next.

14. Type the required Networking Properties and click Next. The window shows the details of the
deployment.

15. Select the Power on after deployment check box.

16. Click Finish. The deployment task starts. After deployment, the virtual appliance name
appears in the tree in the VMware vSphere Client user interface.

Note: For more information, see the VMware documentation. The steps are subject to change
based on VMware.

Logging in to the Virtual Appliance

You can log in to the HP vPV Virtual Appliance using the usemame as root. The default password
is vperf*viewer and it is recommended to change the password after logging in.

Install HP vPV on Linux Nodes

Pre-requisites for Linux-Based Installer

Following are the prerequisites for the Installer version of HP vPV:
¢ Install Libvirt and all its dependencies on the HP vPV server.

Libvirt is an open source management tool to manage virtualized platforms such as Linux, KVM,
Xen, and so on.

Libvirt can be installed on following versions of the different Linux distributions:
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Linux Types OS Versions

CentOS 6.2

6.3
6.4 (64-bit)

RHEL 6.2

o Install Expect and all its dependencies on the HP vPV server.

Expect is a tool that communicates with interactive programs such as ssh.

6.3
6.4 (64-bit)

6.5 (64-bit)

o ForHP vPV standalone installation, install latest unixODBC package, if it is not already
available.

The unixODBC Driver Manager is an open source ODBC driver manager for providing

application developers predictable APIs to access Data Sources.

o Ensure that the host name assigned to RHEL is a Fully Qualified Domain Name (FQDN) and is
resolvable by DNS. If DNS is not configured in the environment, add the IP address machine
name mapping in the /etc/hosts file.

e Toinstall HP vPV, the following runtime libraries and packages are required:

= Onx64 systems:

o

glibc-2.3.4-2.36.i1686.rpm
libgcc-3.4.6-8.i386.rpm
libstdc++-3.4.6-8.i386
libtool-1tdl-2.2.6-15.5.€16.x86_64.rpm
unixODBC-2.2.14-12.el6_3.x86_64.rpm
ntpdate-4.2.6p5-1.e16.x86_64.rpm
libedit-2.11-4.20080712cvs.1.€l6.x86_64.rpm
ntp-4.2.6p5-1.el6.x86_64.rpm

gdb-7.2-60.€l6_4.1.x86_64.rpm (for installing pstack)
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o mcelog-1.0pre3 20120814 2-0.13.€l6.x86_64.rpm
o sysstat-9.0.4-22.el6.x86_64.rpm
= To check the packages, use the following command:
rpm -ga | grep -i <packagename>
In this instance, <packagename> is the name of the package to be checked for.
» C++ runtime:
o For systems with kernel version 2.6:
lusrl/lib/libstdc++.s0.5
o For systems with kernel version 2.6 on Itanium :
lusr/lib/libstdc++.50.6
» Curses runtime library:
{usr/lib/libncurses.so.5
= unixODBC runtime library:
{usr/lib64/libodbc.so
= Make sure that the m4 utility is installed at the path /usr/bin/m4.

= Set the executable (x) bit for the libvirt library at one of the following paths as appropriate for
your environment:

o lusr/lib64/libvirt.so
o [usr/lib64/libvirt.so.0
o [usr/lib/libvirt.so
o [usr/lib/libvirt.so.0
= To set the timezone, run the following command:
# env | grep Tz
TZ=ESTSEDT

Pre-requisites for HP Vertica:
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o HP Vertica does not support Logical Volume Manager (LVM) on any drive where database files
are stored. HP vPV installer will exit if /var/opt partition is LVM.

o Linux Filesystem type must be either ext3 or extd. All other filesystem types are not supported.

o Swap partition of at least 2 GB or larger is required irrespective of the amount of RAM installed
on the system.

¢ Minimum 1 GB of RAM per logical processor.

For more information on the Pre-requisites for HP Vertica, see HP Vertica Analytic Database
Installation Guide

You can install HP vPV by using any of the following procedures:
o "Attended Installation"

¢ "Unattended Installation"

Note: To install HP vPV on your system, you must log on as root user.

Attended Installation

Toinstall HP vPV through Graphical and command line interface, follow these steps:
Installing HP vPV through Graphical Interface

Toinstall HP vPV using X11 interface, perform the following tasks:

1. Login as aroot user.

2. Place the HP vPV CD/DVD-ROM media in the CD/DVD drive. If necessary, mount the
CD/DVD-ROM.

3. Tostartinstallation, if you want to use the X11 terminal window, export the DISPLAY variable
to point to an X11 terminal type the following command:

export DISPLAY=<IP Address/system_name>:0.0

where, <IP_Address/system_name> is the IP address or the system name of the X11
terminal.

4. Type the following:
<CD/DVD-ROM> HPPV_2.01.xxx_setup.bin

where, <CD/DVD-ROM> is the drive letter of the CD/DVD ROM.
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The HP vPV Installation wizard appears. This window displays an introductory message.

Note: If you are installing HP vPV for the first-time on your Linux system, the
ovinstallparams.ini file containing the installation parameters is created in the
system’s temporary directory. During installation, HP Installer checks for the
ovinstallparams.ini file. If HP Installer detects the ovinstallparams.ini file on your
system, a message asking if you want to reuse the values in the file appears.

= Click Yes to use the values in the configuration file as default values.
= Click No to overwrite the existing configuration file.
If HP Installer does not find the file, the system creates the ovinstallparams.ini file

with default values in the temporary directory. To save the ovinstallparams.ini data,
copy the file to an alternate location, before installing other HP products.

5. Onthe HP vPV Installation wizard, click Next. The License Agreement screen appears.

6. Read the terms of license agreement. To continue with installation, select | accept the terms
of License Agreement option. The installation wizard performs install checks.

7. Click Next. The Pre-Install Summary screen appears. The screen displays the list of
components that will be installed.

Note: If HP vPV version 2.00 is present on the system, you would asked to do a forced re-
installation of already installed component packages.

8. Click Install.

Note: If the installation fails, you can roll back or quit installation. The Roll Back option
removes the components which are already installed.

Clicking Quit stops the installation, but does not uninstall the components installed till
then.

When you start HP vPV installation next time, the Installer prompts you to confirm if you
want to resume the installation or uninstall HP vPV.

9. Click Details tab and expand the components tree to view the list of components.
10. Toview the log file on your system, click View Log Files.

11. Click Done to complete the installation.

Note: If the system needs to be restarted, the following message appears after installation
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is complete: ‘You may need to restart your system for the configuration changes made to
the system to take effect. Would you like to quit this installation?’.

It is recommended that you restart your system after installation.

Installing HP vPV through Command Line Interface

Note: Localization is not supported when installing HP vPV in console mode. As a resullt,
some text may be illegible.

Toinstall HP vPV through Command Line interface, follow these steps:

1.

2.

Login as aroot user.

Insert the HP vPV CD/DVD-ROM media into the CD/DVD drive. If necessary, mount the
CD/DVD-ROM.

Run the following command:

If you are installing HP vPV on a stand-alone system:
<CD/DVDROM_mount>/HPPV_2.01.xxx_setup.bin -i console
where, <CD/DVD-ROM=> is the drive letter of the CD/DVD ROM.

If you have configured the locale of the system to one of the following languages: English,
Japanese, and Simplified Chinese, the installer prompts you to select the language at the
beginning of the installation. You will have the option of choosing the language to which your
system locale is set. If the system locale is set to any other language apart from these, the
installer displays only ‘English’.

When the prompt, | accept the terms of the License Agreement for the License information
appears, type Y to accept the terms and continue installation. The installer checks all the
Install Requirements.

Click Enter to continue. The pre-installation summary appears.

Note: If HP vPV version 2.00 is present on the system, you would asked to do a forced re-
installation of already installed component packages. Select Yes to continue.

Click Enter to continue.

When the installation is complete, you will receive a message which states that the installation
was completed successfully.
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Unattended Installation

To carry out unattended installation, follow these steps:
1. Login as a root user.

2. Insert the HP vPV CD/DVD-ROM media into the CD/DVD drive. If necessary, mount the
CD/DVD-ROM.

3. Gotothe directory where the CD/DVD-ROM is mounted.
4. Type the following syntax at the command prompt:

./HPPV_2.01.xxx_setup.bin -i silent

Note: If the installer finds a working installation of HP vPV, it will uninstall HP vPV when
yourunthe -i silent command. If not, it will install HP vPV.

5. To verify the installation, check the log files.

You can view the HP vPV installer log file at /tmp/HPOvInstaller/HPPVInstalllLog.txt

Verify the Installation

On successful installation:
o The Linux systems display the application directory and data directory paths.
e Toview install log files see the following:
For Linux: /tmp/HPPV_1.xx.xxx_HPPVInstaller.txt
/var/tmp/HPPVInstaller/PerfUtil-mm-dd-yyyy.log.0

In this instance, mm indicates the month, dd indicates the day, and yyyy indicates the year. The
file name indicates the time stamp when the install was performed.
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Chapter 5: Getting Started

Afterinstalling HP vPV, you can start using the product by accessing the user interface. To launch
HP vPV, you can use the following URL:

http://<system>:<port>/PV OR https://<system>:<port>/PV.
Note: PV is case sensitive.

If authentication is enabled, log in using the user name and password. The Admin page opens for
the first time.

To start using the product, add the data sources to be monitored. For more information on adding
data sources, see the HP Virtualization Performance Viewer Online Help..
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The following section details different methods to configure HP vPV:
o Configure Secure Communication with Tomcat Server

o Add avCenter server running on a non-default port

Configure Secure Communication with Tomcat
Server

The HTTP and HTTPS protocols are by default enabled for HP vPV. The default port numbers for
HTTP and HTTPS are 8081 and 8444 respectively. You can choose to use either of the protocols.
However, to ensure security for administration-related tasks, you must access HP vPV in the
secure communications mode. To access HP vPV in the secure mode, use the following URL:

https.//<systemname>:8444/PV

To access HP vPV in the non secure mode, use the following URL:
http.//<systemname>:8081/PV

You can also change the default port settings for both HTTP and HTTPS communications.
Changing Port Settings

The default HTTP port number to access HP vPV is 8081 and the default port number for secure
connection is 8444. All client systems are authorized to connect to HP vPV server. To change the
default port number for the HP vPV server, follow these steps:

1. Check for the availability of the port number you want to use, by running the following
commands at the command prompt:

cd <bin_dir>
ovtomcatbctl -checkport <portnumber>

A message indicating if the port is available or in use appears. For example, if you are checking
for the availability of the port number 8081, the message, “Port Number 8081 is not in use”
appears, if the port number is available. If the Port Number 8081 is not available, a message
indicating that the port number is used by another program or service appears.

2. Stop HP vPV by running the following command at the command prompt:
pv stop

3. Tochange http or https port numbers for HP vPV server, run the following command at the
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command prompt:

cd <bin_dir>

ovconfchg -ns NONQOV. TomcatB -Set HTTPPort <port number>

ovconfchg -ns NONQV. TomcatB -Set HTTPSPort <port number>
4. Start the HP vPV server.

Disabling Secure Communications

To disable secure communications, perform the following steps:
1. StopHP vPV, if HP vPV is running.
2. Run the following command at the command prompt:
cd <bin_dir>
ovconfchg -ns NONOV. TomcatB -set EnableHTTPS False

Note: To enable secure communication again, set the value to True, instead of False, in
the preceding command.

3. Restart HP vPV.

Using SSL or HTTPS with the Tomcat Web Server

Touse SSL or HTTPS protocols with the Tomcat web server, you need to obtain a server certificate
for Tomcat after installing HP vPV. You can replace the certificate obtained after HP vPV
installation in the following scenarios:

o When you connect to HP vPV using HTTPS protocol, the certificate and name of the system are
compared to ensure that the names match. If the names are not similar, most browsers alert the
users so that they can decide to either continue or cancel the connection. If the name used by
HTTPS users is different from the name used by the HP vPV installation, you must obtain a
different certificate.

¢ You may need to obtain a new certificate when you want to fill the fields in the certificate that are
left blank during HP vPV installation. The certificate contains many fields to provide information,
such as, the issuer of the certificate and other fields that warrant the safety provided by the
certificate. The HP vPV installation certificate leaves most of these fields blank.

« When you want to change the default certificate password to avoid unauthorized changes, you
must replace the existing certificate.

To replace the Tomcat SSL certificate, perform the following steps:
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1. Delete the existing certificate by running the following command at the command prompt.

keytool -delete -alias ovtomcatb -keystore /var/opt/OV/certificates/tomcat/b/tomcat. keystore
The keytool path on Linux is /opt/OV/nonOV/jre/b/bin
2. Restart HP vPV.

3. Create a new certificate. To create a new certificate, run Keytool by entering the following
commands at the command prompt:

keytool -genkey -alias ovtomcatb -keyalg RSA -keystore
/var/opt/OV/certificates/tomcat/b/tomcat. keystore

4. Restart HP vPV.

Add a vCenter server running on a non-default port

vCenter Server system requires port 443, for connections from the vSphere and Software
Development Kit (SDK) clients. By default, vCenter collector of HP vPV 2.0 uses port 443 for data
collection from vCenter server. If this default port 443 is re-configured in your environment due to
any reason, it is recommended to use the iptables to route the traffic.

During the HP vPV 2.0 installation, run the iptables command and setup port forwarding rules for
each of the target.

Follow the steps:
1. Logon as aroot user.
2. Run the following command:

iptables -t nat -A OUTPUT -p tcp -m tcp -d <target vcenter(s) ip> --dport 443
-j DNAT --to-destination <target vcenter(s) ip>:<target ports

In this instance, <target vcenter(s) ip> is the ip address of the target vCenter and <target
port> is the port number of the target.

Using HP vPV Commands

After you install HP vPV, you can use the following commands to administer the HP vPV
workspace through the command prompt.
<bin_dir>/pv <Options>

You can replace <Options> with any of the following variables:
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o status - To check the HP vPV status.
o start- Tostart HP vPV.

All the applications that use OvTomcatB are started when you run pv start command.
e stop-Tostop HP vPV.

All the applications that use OvTomcatB are stopped when you run pv stop command.
o restart - To stop and then start HP vPV.
o trace on - To start generating detailed trace files.
o trace off - To stop generating detailed trace files.

o version - To display the version of HP vPV installed on your system.
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After youinstall HP vPV, you can purchase the appropriate licenses based on your business
requirements. These licenses enable you to access all the features of the product. To purchase the
respective license, click You have Evaluation/Community license. Click to buy license link.
The link navigates to the Buy License page. Enter your details in the Contact Me tab and click
Submit. Make sure email client is configured in your browser.

To access the License tab on the HP vPV user interface:
1. Logintothe HP vPV user interface to import licenses.
2. Select Admin from the HP vPV home page.
The License Management tab provides information about your HP vPV licenses. You can also use

this tab to start using your Evaluation License as well as import a HP vPV license. For more
information on importing licenses, see "Importing Licenses".

Note: If you install an Express license on the HP vPV server which uses a Community
license, then the Community license expires.

If you want to retain the Community license, create a separate HP vPV server to install the
Express license.

For more information on the difference between the licenses and the features available, see "Types
of Licenses"

User Interface

The following table lists the sections available in the License Management tab.

Section Description

License Status = Displays information regarding the installed licenses. The two tables available
are:

o Active License Features

o Installed Licenses

Manage To import permanent licenses.
License

The Active License Details table lists the following information about your current HP vPV
License:
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o Capacity or number of instances available corresponding to each license.
o Number of instances that can be monitored, based on the installed license
o Data Retention

The Installed Licenses table lists the following information regarding the active and all installed
licenses for HP vPV:

e Type of license installed

o Date of license expiry

Types of Licenses

The following table lists the available features for the Community, Express, Premium, and
Evaluation HP vPV Licenses:

Community Express Premium Evaluation
Feature License License License License

Number of Instances 25instances @ 6000

Tested up to 6000 instance. Larger
configurations can be supported. For more
information, see the HP vPV Sizing Guide.

Data Retention Upto24 90 days 90 days 60 days
hours

Enterprise Directory Integration No Yes Yes Yes
Reports Yes Yes Yes Yes
HP OM, HP PM and HP BSM No Yes Yes Yes
Integration

HP CSA Integration No No Yes Yes
Guest Operating System drill No No Yes Yes
down for advanced

troubleshooting

Current Capacity Reports (Only No No Yes Yes
for VMware™ vSphere and
Microsoft™ HyperV)

Best-fit Capacity Optimization No No Yes Yes
(Only for VMware™ vSphere and
Microsoft™ HyperV)
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Community Express
Feature License License
Virtual Machine Placement (Only No No

for VMware™ vSphere )

Capacity Demand Forecast No No
(Only for VMware™ vSphere and
Microsoft™ HyperV)

Alerting (Only for VMware™ No Yes
vSphere )
Capacity Modeler (Only for No No

VMware™ vSphere )

Dashboard No No

Note: The number of instances denote only the VMs and hosts.

Premium
License

Yes

Yes

Yes

Yes

Yes

Evaluation
License

Yes

Yes

Yes

Yes

Yes

All product features are available for the Evaluation License. The only difference between the

Evaluation License and Premium License is the validity.

Evaluation License

After installing HP vPV, by default, your active license will be Community License. To start using
your Evaluation License, click Start Evaluation. The page refreshes and displays information

regarding your Evaluation License.

After the Evaluation License expires (after 60 days), the system changes your license

automatically to Community License.

Note: Data collection works only when the sum of instances from all data sources is less than
or equal to the maximum instance capacity of the license. If the total instance count exceeds
the maximum instance capacity of the license, then connection for all the data sources fails.
For example, if you install a Premium license for 100 instances, and try to connect two hosts

with 60 instances each, then the collection fails for both the hosts.

License Validity

The following table lists the validity of the different HP vPV licenses:

License Validity

Community = Not Applicable

Evaluation = 60 days

Premium Depends on the date when license is ordered

Express Depends on the date when license is ordered
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Importing Licenses
After you purchase a license, you must import it before you start using HP vPV.
To import licenses for HP vPV, follow these steps:
1. Gotothe License Management tab in Admin page.
2. Type yourlicense key in the License Key field of the Manage License section.

3. Click Import License. The License Status section refreshes to display the details of the
license imported.

To clear the license key typed in, click Reset.
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You can remove HP vPV installed on Linux systems by using the procedure described in the
following section:

HP vPV Virtual Appliance

To remove the HP vPV virtual appliance, power off the VM and delete the VM.

Remove HP vPV from Linux Nodes

To remove HP vPV from a Linux system:
1. Logon as root user.
2. Goto /opt/0OV/Uninstall/HPPV.

3. Run the uninstall command:

= Touse an X11 interface, export the DISPLAY variable to point to an X11 terminal if
necessary. Then run the command:

./setup.bin
= Touse acommand line interface, run the command:
./setup.bin -i console

4. Select Uninstall.

Removing Configurations and User Graph Templates

Removing HP vPV does not remove configurations or user graph templates. You need to manually
remove the files from the data directory.

Removing HP vPV Files using the Clean-up Script

After removing HP vPV, you must run the following clean-up script. This script is available in the
<install_dir>\support:

e clnup_pv.sh forLinux

The clean-up script removes the following files from <data_dir>\conf\pert:
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e OVPMconfig.ini

e OVPMUsers.xml

e OVPMSystems.xml

e ovpm.tcf

e VPI_GraphsUserFavorites.txt

e OVPMReportTemplate.htm

o All folders starting with the name "vPI_".

o All PV database related files

Note: If you plan to reinstall HP vPV on the same system, make sure you delete the following
folders after you finish running the clean-up script:

o /opt/OV/
o /opt/vertica/

o /var/opt/QV/
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The following section details how to troubleshoot HP vPV:

Vertica database is filled to near capacity due to the increase in the log file size.
Symptom | The Vertica database is filled to near capacity due to the increase in the log file size.

Causes Vertica database consolidates and retains the log data in a .gz file daily. By default,
this process (called ‘rotate’) continues for 52 weeks.

Resolution = To create more space on the Vertica database implement any one of the two
solutions below:

Solution 1
1. Go to/opt/vertica/config/logrotate/.
2. Openthe pv file.

3. Inthe pv file, under # and keep for 52 weeks change the value of rotate from
52 to the number of weeks for which you want to save the rotated log files.

For example: rotate 3
In this instance, the Vertica database will retain the .gz files for 3 weeks.
4. Repeat step 3 for all instances of # and keep for 52 weeks.
5. Save and close thefile.
Solution 2
1. Login as aroot user.
2. Runthe following commands on the HP vPV server:
cd /opt/vertica/bin
./admintools -t logrotate -d pv -r weekly -k <number_of weeks>

where, <number_of weeks> is the number of weeks for which you want to
retain the rotated logs.

Unable to Access HP vPV

Symptom | Unable to access HP vPV through the default network port settings.
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Causes ¢ Yoursystem has ovTomcatB configured to run with the non-root user or non-
local system account privileges and you have HP vPV installed on such a
system.

e You cannot access HP vPV using the default http (8081) or https (8444) ports if
these ports are in use by other applications.

Resolution e Check if ovTomcatB is configured to run with the non-root user or non-local
system account privileges. If so, modify the settings to run ovTomcatB with the
Administrator or root user privileges.

e Try accessing HP vPV by using the following URL:
http://<IP address/system name>:<port number>/PV

where, <IP address/system name> is the |P address or the system name of the
HP vPV server and <port number> is the port number of the HP vPV server.

If the HP vPV Home page does not appear, check if the default ports are in use.
e Tochange the port settings, follow these steps:

1. Run the following command at the command prompt to change the port
numbers for HTTP, HTTPS, and ShutdownPorts:
<bin_dir>ovconfchg -ns NONQOV. TomcatB -set HTTPPort <port number>

<bin_dir>ovconfchg -ns NONOV. TomcatB -set HTTPSPort <port number>
<bin_dir>ovconfchg -ns NONOV. TomcatB -set ShutdownPort <port number>

2. Restart HP vPV.

Unable to connect to HP vPV server through HTTPS protocol

Symptom | HP vPV is unable to connect to the server through secure communication (HTTPS)
protocol.

Cause The connection times out when HP vPV is not able to connect through the secure
client in the default timeout interval of one second.

Resolution = Use the parameter SECURE_CLIENT_CONNECT_TIMEOUT to adjust the
timeout interval to connect to HP vPV server depending on your Internet
connectivity or infrastructure setup.

Deployment of HP vPV fails
Symptom | The deployment of the HP vPV Virtual Appliance fails.
Cause This may happen when the time on the ESX server is set to a future time.

Resolution = Ensure that the time on the ESX server is set correctly.
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Unable to view content on HP vPV home page

Symptom | The HP vPV Home page does not display anything except the header.

Cause JavaScript is not supported or Adobe® Flash Player is not installed in your browser.
Adobe® Flash Player version 10.3 is the minimum required version.

Resolution = Install Adobe® Flash Player and enable JavaScript support for the Internet Explorer
(IE) or Mozilla Firefox browser by adding HP vPV to your list of Trusted Sites.

e Toadd HP vPV Web server URL to a trusted site, perform the following steps:

For |IE browser

a.

g.
h.

From the Tools menu, click Internet Options. The Intemnet Options pop-up
window appears.

Click Security tab.
Select the Trusted Sites icon.
Click Sites. The Trusted Sites pop-up window appears.

Type the HP vPV web server URL and click Add. The typed URL appears in
the list of trusted sites.

Click Close.
Click OK.

Restart the browser.

For Mozilla Firefox browser

a.

b.

C.

d.

From the Edit menu, click Preferences. The Options pop-up window appears.
Click Privacy tab.

Click Exceptions.

Type the HP vPV web server URL in the box under Address of web site.

Click Allow.

Click Close.

Click OK.

Restart the browser.
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Resolution e If Adobe® Flash Player is not installed in your browser, HP vPV Home page
does not appear. The browser displays a message stating that you must Install
Adobe Flash Player to view the HP vPV Home Page. Click the message to
download Adobe® Flash Player.

e If JavaScript is not enabled in your browser, HP vPV Home page does not
appear in the IE browser even after adding it as a trusted site. The browser
displays a message stating that JavaScript is not enabled in your browser and
you must enable JavaScript to view the page.

To enable JavaScript support, perform the following steps:

For IE browser

a. From the Tools menu, click Internet Options. The Internet Options pop-up
window appears.

b. Click the Security tab. Check if the security level in your browser settings is
set to High.

c. Make sure the Trusted Sites icon is selected and click Custom Level. The
Security Settings pop-up window appears.

d. Scroll down to Scripting section and select the Enabled option under Active
Scripting.

e. Click OK.
f. Click Apply.

For Mozilla Firefox browser:

a. From the Tools menu, click Options.
b. Click Content.
c. Select the Enable JavaScript check box.

d. Click OK.

HTTP Status 404 - /PV Error
Symptom = When trying to access HP vPV, you get the HTTP Status 404 - /PV Error message.
Cause The message appears if the <INSTALLDIR>/www/webapps/PV directory is empty.

Resolution  Extract the Perf.war file again from <Install_Dir>/newconfig/PV to <Install _
dir>/www/webapps/PV. Run the command pv deploywar.

What are the log files available with HP vPV?
The following table lists the log files available with HP vPV:
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Component

pvcd (PV
Collection
Daemon)

Collectors

Database
Transaction

User Interface

Description

pvcd daemon uses XPL tracing
mechanism. A default pvcdXPL.itc (trace
configuration) is available in
/opt/0V/support directory.

To start the tracing, run
/opt/0OV/support/ovtrccfg -app
pved -cf
/opt/0OV/newconfig/conf/xpl/trc
/pvcdXPL. itc The XPL trace files are
present at /tmp/pvcd_*.trc.

To stop tracing, run
/opt/0OV/support/ovtrccfg —-app
pvcd -off

pvcd and pvconfig tools log important
status and error messages, if any, in
System.txt.

vCenter and OpenStack collector status
log file
/var/opt/0V/log/status.virtserver

KVM collector status log file

XEN collector status log file

Vertica catalog file to view database
transactions

Local trace and log messages are logged in
ovpmtrace.0.txt and ovpm.@.log

HP Virtualization Performance Viewer (2.01)

Location

If tracing is enabled, /tmp/
directory contains the trace files
(use - 1s /tmp/pved

* trc)

/var/opt/0V/log/System.txt

/var/opt/0V/log/status.virt
server

/var/opt/0V/log/status.kvm

/var/opt/0V/log/tmp/status.
xen

/var/opt/0V/databases/pv/ca
talog/pv/v_pv_node00ol_
catalog/vertica.log

/var/opt/0V/log
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Virtual Appliance

The RPMs packaged with the HP vPV Virtual Appliance are as follows:

o setup-2.8.14-20.el6.noarch
o basesystem-10.0-4.el6.noarch

o tzdata-2012j-1.el6.noarch

¢ glibc-common-2.12-1.107.el6.x86_64

e ncurses-libs-5.7-3.20090208.€16.x86_64

o libattr-2.4.44-7.€16.x86_64

o Zzlib-1.2.3-29.€16.x86_64

o audit-libs-2.2-2.e16.x86_64

e popt-1.13-7.el6.x86_64

o db4-4.7.25-17.€l6.x86_64

e nspr-4.9.2-1.el6.x86_64

e bzip2-libs-1.0.5-7.€l6_0.x86_64
o libselinux-2.0.94-5.3.el6.x86_64
o sed-4.2.1-10.el6.x86_64

o glib2-2.22.5-7.€l6.x86_64

o gawk-3.1.7-10.el6.x86_64

o sqlite-3.6.20-1.€16.x86_64

o libxml2-2.7.6-8.el6_3.4.x86_64

o libstdc4.4.7-3.€l6.x86_64

o dbus-libs-1.2.24-7.€l6_3.x86_64
e grep-2.6.3-3.el6.x86_64

o findutils-4.4.2-6.e16.x86_64
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e cyrus-saslib-2.1.23-13.el6_3.1.x86_64
o libblkid-2.17.2-12.9.e16.x86_64

o keyutils-libs-1.4-4.e16.x86_64

o libgssglue-0.1-11.€l6.x86_64

o libgpg-error-1.7-4.e16.x86_64

e vim-minimal-7.2.411-1.8.€l6.x86_64

o checkpolicy-2.0.22-1.el6.x86_64

e sysvinit-tools-2.87-4.dsf.el6.x86_64

o perl-Pod-Escapes-1.04-129.¢€l6.x86_64
o perl-Module-Pluggable-3.90-129.€16.x86_64
o perlibs-5.10.1-129.el6.x86_64

e pth-2.0.7-9.3.€l6.x86_64

o keyutils-1.4-4.e16.x86_64

e grubby-7.0.15-3.€l6.x86_64

o upstart-0.6.5-12.e16.x86_64

o libusb-0.1.12-23.€l6.x86_64

e nss-softokn-3.12.9-11.el6.x86_64

e Xz-lzma-compat-4.999.9-0.3.beta.20091007git.el6.x86_64
o MAKEDEV-3.24-6.€16.x86_64

o net-tools-1.60-110.el6_2.x86 64

o tar-1.23-11.el6.x86_64

e pinentry-0.7.6-6.€16.x86_64

o e2fsprogs-libs-1.41.12-14.el16.x86_64

¢ which-2.19-6.€16.x86_64

o diffutils-2.8.1-28.€16.x86_64

e dash-0.5.5.1-4.€l6.x86_64
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o groff-1.18.1.4-21.el6.x86_64

o coreutils-libs-8.4-19.€l6.x86_64

o cracklib-2.8.16-4.€l6.x86_64

o coreutils-8.4-19.€l6.x86_64

e module-init-tools-3.9-21.el6.x86_64

o redhat-logos-60.0.14-12.el6.centos.noarch
o libpciaccess-0.13.1-2.€l6.x86_64

¢ rpcbind-0.2.0-11.el6.x86_64

e nss-3.14.0.0-12.el6.x86_64

e nss-tools-3.14.0.0-12.el16.x86_64

o libuser-0.56.13-5.€l16.x86_64

e pciutils-libs-3.1.10-2.€16.x86_64

e mingetty-1.08-5.€l6.x86_64

o Ustr-1.0.4-9.1.€l6.x86_64

o libffi-3.0.5-3.2.e16.x86_64

o newt-0.52.11-3.el6.x86_64

o ca-certificates-2010.63-3.el6_1.5.noarch
¢ python-libs-2.6.6-36.€16.x86_64

o libssh2-1.4.2-1.€16.x86_64

e curl-7.19.7-35.€l6.x86_64

o rpm-4.8.0-32.el6.x86_64

¢ python-pycurl-7.19.0-8.e16.x86_64

e gnupg2-2.0.14-4.€16.x86_64

¢ pygpgme-0.1-18.20090824bzr68.e16.x86_64
¢ yum-metadata-parser-1.1.2-16.€l6.x86_64

o yum-plugin-fastestmirror-1.1.30-14.el6.noarch
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o bind-libs-9.8.2-0.17.rc1.el6.x86_64

o fipscheck-lib-1.2.0-7.e16.x86_64

¢ kbd-misc-1.15-11.el6.noarch

e policycoreutils-2.0.83-19.30.€l6.x86_64
e iproute-2.6.32-23.€16.x86_64

o util-linux-ng-2.17.2-12.9.el6.x86_64

o udev-147-2.46.€l16.x86_64

o plymouth-0.8.3-27.€el6.centos.x86_64
¢ dracut-004-303.el6.noarch

e rsyslog-5.8.10-6.e16.x86_64

e cyrus-sasl-2.1.23-13.el6_3.1.x86_64

e cronie-anacron-1.4.4-7.€l6.x86_64

¢ crontabs-1.10-33.el6.noarch

o nfs-utils-1.2.3-36.e16.x86_64

o selinux-policy-3.7.19-195.el6.noarch

¢ kernel-firmware-2.6.32-358.¢l6.noarch
o dhclient-4.1.1-34.P1.el6.centos.x86_64
o system-config-firewall-base-1.2.27-5.el6.noarch
¢ bfa-firmware-3.0.3.1-1.el6.noarch

¢ iwl100-firmware-39.31.5.1-1.el6.noarch
o b43-openfwwf-5.2-4.el6.noarch

¢ aic94xx-firmware-30-2.el6.noarch

¢ iwl1000-firmware-39.31.5.1-1.el6.noarch
o authconfig-6.1.12-13.el6.x86_64

o gettext-0.17-16.e16.x86_64

e grub-0.97-81.el6.x86_64
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o wget-1.12-1.8.el6.x86_64

e passwd-0.77-4.el6_2.2.x86_64

o audit-2.2-2.el6.x86_64

e acl-2.2.49-6.el6.x86_64

o (l2400-firmware-5.08.00-1.el6.noarch

e @l2100-firmware-1.19.38-3.1.el6.noarch

o libertas-usb8388-firmware-5.110.22.p23-3.1.el6.noarch
o l2500-firmware-5.08.00-1.el6.noarch

o zd1211-firmware-1.4-4.el6.noarch

o rt61pci-firmware-1.2-7.el6.noarch

o (l2200-firmware-2.02.08-3.1.el6.noarch

o ipw2100-firmware-1.3-11.el6.noarch

o ipw2200-firmware-3.1-4.el6.noarch

o vmware-studio-vami-tools-2.6.0.0-631426.x86_64

o vmware-studio-vami-servicebase-2.6.0.0-631426.x86_64
o vmware-studio-vami-service-system-2.6.0.0-0.x86_64
o vmware-studio-vami-service-oaconfig-1.0.0.0-0.x86_64
o vmware-studio-appliance-config-2.6.0.0-130820235403.noarch
o vmware-studio-vami-login-2.6.0.0-631426.x86_64

o libgcc-4.4.7-3.€16.x86_64

o filesystem-2.4.30-3.€l6.x86_64

e ncurses-base-5.7-3.20090208.€16.x86_64

o nss-softokn-freebl-3.12.9-11.e16.x86_64

o dlibc-2.12-1.107.€l6.x86_64

o bash-4.1.2-14.€l6.x86_64

o libcap-2.16-5.5.€l6.x86_64
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e info-4.13a-8.€l6.x86_64

o libcom_err-1.41.12-14.el6.x86_64

o chkconfig-1.3.49.3-2.€l6.x86_64

o libacl-2.2.49-6.€16.x86_64

e nss-util-3.14.0.0-2.€l6.x86_64

o libsepol-2.0.41-4.€l6.x86_64

o shadow-utils-4.1.4.2-13.el6.x86_64
e gamin-0.1.10-9.el6.x86_64

o readline-6.0-4.e16.x86_64

o Xxz-libs-4.999.9-0.3.beta.20091007git.€l6.x86_64
o libidn-1.18-2.€16.x86_64

o file-libs-5.04-15.€16.x86_64

o tcp_wrappers-libs-7.6-57.e16.x86_64
e pcre-7.8-6.e16.x86_64

o lua-5.1.4-4.1.el6.x86_64

o bzip2-1.0.5-7.el6_0.x86_64

o libuuid-2.17.2-12.9.e16.x86_64

e expat-2.0.1-11.el6_2.x86_64

o krb5-libs-1.10.3-10.€l6.x86_64

o elfutils-libelf-0.152-1.€16.x86_64

o libtirpc-0.2.1-5.€16.x86_64

o libselinux-utils-2.0.94-5.3.€l6.x86_64
e Cpio-2.10-11.el6_3.x86 64

o gdbm-1.8.0-36.e16.x86_64

o perl-version-0.77-129.el6.x86_64

o perl-Pod-Simple-3.13-129.el6.x86_64
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o perl-5.10.1-129.el6.x86_64

o libgcrypt-1.4.5-9.el6_2.2.x86_64

o dbus-glib-0.86-5.€16.x86_64

o libnih-1.0.1-7.€16.x86_64

e gmp-4.3.1-7.€l6_2.2.x86 64

o file-5.04-15.e16.x86_64

o xz-4.999.9-0.3.beta.20091007git.el6.x86_64
o libutempter-1.1.5-4.1.€l6.x86_64

e procps-3.2.8-25.€16.x86_64

e psmisc-22.6-15.el6_0.1.x86_64

o db4-utils-4.7.25-17.€16.x86_64

o libss-1.41.12-14.€l6.x86_64

e m4-1.4.13-5.€l6.x86_64

o libgomp-4.4.7-3.€l6.x86_64

o binutils-2.20.51.0.2-5.36.e16.x86_64
e ncurses-5.7-3.20090208.€l6.x86_64
o less-436-10.el6.x86_64

e gzip-1.3.12-18.€l6.x86_64

o cracklib-dicts-2.8.16-4.€l6.x86_64
e pam-1.1.1-13.el6.x86_64

¢ hwdata-0.233-7.9.el6.noarch

o plymouth-scripts-0.8.3-27.el6.centos.x86_64
e cvs-1.11.23-15.el6.x86_64

o logrotate-3.7.8-16.€l6.x86_64

e nss-sysinit-3.14.0.0-12.e16.x86_64

o openldap-2.4.23-31.€l6.x86_64
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e libcap-ng-0.6.4-3.el6_0.1.x86_64

o ethtool-3.5-1.e16.x86_64

o libevent-1.4.13-4.el6.x86_64

o libsemanage-2.0.43-4.2.€l6.x86_64

e slang-2.2.1-1.el6.x86_64

o plymouth-core-libs-0.8.3-27.el6.centos.x86_64
e openssl-1.0.0-27.el6.x86_64

e python-2.6.6-36.€l16.x86_64

o libcurl-7.19.7-35.€16.x86_64

o rpm-libs-4.8.0-32.€16.x86_64

o rpm-python-4.8.0-32.€l16.x86_64

o python-urigrabber-3.9.1-8.el6.noarch
e gpgme-1.1.8-3.€l6.x86_64

o newt-python-0.52.11-3.€l6.x86_64

e python-iniparse-0.3.1-2.1.el6.noarch

e yum-3.2.29-40.el6.centos.noarch

o mysql-libs-5.1.66-2.el6_3.x86 64

o fipscheck-1.2.0-7.€l6.x86_64

o centos-release-6-4.el6.centos.10.x86_64
o iptables-1.4.7-9.€l6.x86 64

o iputils-20071127-16.€l6.x86_64

o initscripts-9.03.38-1.el6.centos.x86_64
o libdrm-2.4.39-1.€16.x86_64

o kbd-1.15-11.el6.x86_64

¢ dracut-kernel-004-303.el6.noarch

e openssh-5.3p1-84.1.el6.x86_64
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postfix-2.6.6-2.2.el6_1.x86_64
cronie-1.4.4-7.e16.x86_64
nfs-utils-lib-1.1.5-6.e16.x86_64
iptables-ipv6-1.4.7-9.e16.x86_64
dhcp-common-4.1.1-34.P1.el6.centos.x86_64
kernel-2.6.32-358.¢€l6.x86_64
selinux-policy-targeted-3.7.19-195.¢el6.noarch
openssh-server-5.3p1-84.1.€l6.x86_64
iwl5150-firmware-8.24.2.2-1.el6.noarch
iwl6050-firmware-41.28.5.1-2.el6.noarch
iwl6000g2a-firmware-17.168.5.3-1.el6.noarch
iwl6000-firmware-9.221.4.1-1.el6.noarch
bind-utils-9.8.2-0.17.rc1.el6.x86_64
man-1.6f-32.el6.x86_64
libxml2-python-2.7.6-8.€l6_3.4.x86_64
gdb-7.2-60.e16.x86_64
efibootmgr-0.5.4-10.€l6.x86_64
sudo-1.8.6p3-7.€l6.x86_64
e2fsprogs-1.41.12-14.el6.x86_64
attr-2.4.44-7.€l6.x86_64
iwl5000-firmware-8.83.5.1_1-1.el6_1.1.noarch
ivtv-firmware-20080701-20.2.noarch
xorg-x11-drv-ati-firmware-6.99.99-1.el6.noarch
atmel-firmware-1.3-7.el6.noarch
iwl4965-firmware-228.61.2.24-2.1.el6.noarch

iwl3945-firmware-15.32.2.9-4.¢el6.noarch
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o rt73usb-firmware-1.8-7.el6.noarch

o l23xx-firmware-3.03.27-3.1.¢el6.noarch

¢ rootfiles-8.1-6.1.el6.noarch

¢ vmware-studio-init-2.6.0.0-130820235404.noarch

o vmware-studio-vami-cimom-2.6.0.0-631426.x86_64

o vmware-studio-vami-service-core-2.6.0.0-0.x86_64

o vmware-studio-vami-service-network-2.6.0.0-0.x86_64
o vmware-studio-vami-service-update-2.6.0.0-0.x86_64

o vmware-studio-vami-lighttpd-2.6.0.0-631426.x86_64
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We appreciate your feedback!

If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on Installation Guide (Virtualization Performance Viewer 2.01)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client,
and send your feedback to docfeedback@hp.com.
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